Microsoft Word XP

Notes prepared by

John O’Connell

Suitable for

ITF 201 Basic Operations Word Processing

Computers for Seniors: Word Processing & Desktop Publishing

ICAITU006B - Operate Computer Packages

EMM111
# Table of Contents

MICROSOFT WORD XP .............................................................................1

NOTES PREPARED BY ...........................................................................1

JOHN O’CONNELL ..................................................................................1

SUITABLE FOR ......................................................................................1

ITF 201 Basic Operations Word Processing...........................................1
Computers for Seniors: Word Processing & Desktop Publishing...........1
ICAITU006B - Operate Computer Packages..........................................1

**TABLE OF CONTENTS** .......................................................................2

**STARTING WORD** ...........................................................................1

- Title Bar.......................................................................................... 1
- Menu Bar.......................................................................................... 2
- Standard Toolbar.............................................................................. 2
- Formatting Toolbar.......................................................................... 2
- Ruler.................................................................................................. 3
- Status Bar......................................................................................... 3
- Scroll Bars....................................................................................... 3
  - Exercise 1................................................................................... 5
  - Exercise 2................................................................................... 6
- The New Button................................................................................ 7
  - Exercise 3................................................................................... 7

**SAVING** ..........................................................................................8

- Exercise 4....................................................................................... 9
- To Save As...................................................................................... 9
- Exercise 5....................................................................................... 9

**DIFFERENT VIEWS IN WORD** ........................................................10

- Exercise 6......................................................................................10

**SELECTING** ..................................................................................11

- Select Text and Graphics by Using the Mouse and Other Ways..........11

**FORMATTING** ...............................................................................12

- To Highlight Text We Can Use the .................................................12
  - Exercise 7...................................................................................12

**ALIGNMENT** ................................................................................14

- Left Aligned....................................................................................14
- Right Aligned..................................................................................14
- Centre Aligned................................................................................14
- Justified............................................................................................14
  - Exercise 8...................................................................................14

**CUT, COPY PASTE SPELLING** ........................................................15

- Cut.....................................................................................................15
- Copy..................................................................................................15
- Spelling.............................................................................................16
  - Exercise 9...................................................................................16

**SPELLING** ......................................................................................17
MORE FORMATTING

This dialogue box appears and look at the choices

Exercise 10

FILE OPEN AND SAVE AS

Exercise 11

PAGE SETUP
Starting Word

To start Microsoft Word, there are myriad choices of options. Choose any of the following:

1. Left Click on the Start button, Left Click on Programs, Left Click on Microsoft Word
2. Double Click on the Microsoft Word icon on the desktop
3. Left Click on Microsoft Word on the Office shortcut bar (if present)
4. Right Click on the desktop, Left Click on New, Left Click on Microsoft Word
5. By exploring your computer and finding a word document and double-clicking on it

And then a window containing the programme Word appears with a document inside.

Let's look at all the elements of the window.

Title Bar

It has the Title of the Programme and the document title.

There are also three buttons at the right hand side.

These are Minimise, Maximise and Close.

Sometimes the middle button looks like this.

The middle button is Restore.
The Menu Bar contains all the commands. **Left Click** on any one and a menu drops down and there are more choices. **OR**

Hold down the **Alt** key and click an underlined character and the same happens. Here I have held down the `<Alt>` key and pressed the **I** key on the keyboard.

You can ask for help at the right end of the Menu Bar.

---

**Standard Toolbar**

Contains common commands such as new document, open, save, email, search, print, print preview, spelling, cut, copy, paste and much more.

---

**Formatting Toolbar**

This contains most of the commands to format text, that is to change its font, size, bold bullets etc. This is where we change the look of our document.
Ruler

Grey parts show the margins and the white part is where our text will be and is the printing area. The usual size of paper is A4, which is 21cm wide or 210mm. From the screenshot above the margins are set at 1cm either side. This document you are reading has margins of 1.7cm on both left and right.

Status Bar

Tells us what page we are in, section number, page of what pages, horizontal position

Scroll Bars

One horizontal and one vertical. You can use the arrows or click and drag.

Time for an exercise but first a heap of information

Words that look like this `<Shift>` or this `<Enter>` mean a keyboard action. I may have missed some so call out.

To create a space between words push the `<Space>` bar once – the Space bar is the longest key on the keyboard, generally at the bottom of the keys.

To move down a line press the `<Enter>` key. Word does word-wrap which is not a dance but the ability to automatically move down a line when the first line becomes full. Do NOT use `<Enter>` unless you really do want a new line.

To make one or two capital letters hold down the `<Shift>` key as you press the required keys

To type many capital letters it is easier to press the `<Caps Lock>` key. Press the `<Caps Lock>` key again to revert to standard text.
If you make a mistake in your typing press <Backspace> and the letters to the left of the insertion point will be removed. To remove letters to the right of the insertion point use the <Delete> button.

To print the document the easiest way is to click the printer icon.

If you have red or green wavy lines under your text don’t worry. It is just Word saying you have spelling (red) or grammar (green) mistakes. We will ignore them for now.

If you make a mistake it can be undone by clicking on the Undo button.

And Word will also redo an action – click on the Redo button. Word can undo or redo up to 99 times. If you look carefully at the picture you can see a tiny drop down button – click there and all our work is shown there.

The <Tab> key will be used soon. It is found on the left of the keyboard above the <Caps Lock> usually.
Exercise 1

Type the following letter substituting My Name for your own personal name and when done click the printer icon. Collect it and have a good look at it.

My Name
My Address line 1
My address line 2
MY TOWN
NSW XXXX

Mr John O'Connell
Fairlea
30 Cave Gully Road
NAPOLEON REEF
NSW  2795

Dear John

Re: Your Dogs

We hope your dogs are fit and well and safe at home alone.

Yours faithfully

My Name
Exercise 2

Now your letter will probably be all tucked up in the top of the document and really what I like, is for the document to fill the page (more or less). So get back into the document and spread it over the page more – just use the <Enter> button.

Some more tips

Show or hide nonprinting characters

While you view or edit a document on the screen, you can display characters- such as tab characters, spaces, and carriage returns-that don't appear on the printed page. (For example, Word uses arrows to represent tab characters and dots to represent spaces.) That way, you can easily see if you added an extra space between words, typed spaces instead of a tab character, and so on.

You can turn them on or off by clicking the Show/Hide icon (next to the zoom on the standard toolbar)

As we make our text spread over the page we can no longer see all the text.

To see more of it we can use the vertical scroll bar or the <Page Up> or <Page Down> keys

Or use the arrow keys.

Or

Change the zoom by clicking on the zoom drop down button and choosing from the options

Even though Word shows us preset options we can specify exactly what zoom we need. If you place your cursor over the zoom box you will see the cursor changes to an I shape. This means we can add text directly into the box. One click will see the text become selected and we can type in our choice of zoom. Press <Enter> to complete the dialogue.

Print your revised document and it looks better? – Yes/no.
The New Button

When Word is launched it opens a new document which it calls Document 1
See below

If you click on the New Document icon, another document will open and it will be named Document 2, and so on and so forth. These temporary file names will not change until you do so when you save the document.

Exercise 3

In our new document type the following text – all words in <Bold> are instructions for you. Do NOT use the <Enter> key on the large paragraph – Word will word-wrap it for you.

<Enter>
<Enter>
From: <Tab> <Tab> Your Name <Enter>
<Enter>
To: <Tab> <Tab> John O'Connell <Enter>
<Enter>
Date: <Tab> <Tab> Today’s Date <Enter>
<Enter>
<Enter>
Subject: <Tab> Workload <Enter>
<Enter>
<Enter>
It has become obvious to me that you have a very small workload and pretend that your workload is huge. This has to end or your tenure here will cease. Tomorrow please call to my office and collect three files that need to be completed by next week. If they are not you are out of here without a reference. <Enter>
<Enter>
<Enter>
You are a slacker <Enter>
<Enter>

<Print it as well.>
Saving

Saving allows documents to be stored on our computer so that we can access the file another day or we can take the file with us.

Please, please, please make a habit of saving regularly because if you don’t save and a power cut occurs or the dog pulls out the cord, your work may disappear into the ether. By saving often, we will only lose information from the last save.

When you save you need to give the file a name. Make it meaningful and remember you can have up to 256 characters in the filename. If it is a letter to your friend Phoebe, maybe the file name could be Letter2Phoebe 12Mar01. It is your decision.

Do not use these things (or operators to use the correct terminology) in the filename:
\ / : * ? " < >

When you need to save your work and it is the first time for the file you are working on, Word will display the Save As dialogue box.

In the dialogue box we can rename our file, decide where we will place the file and we can also change the type of file (not covered in this class)

**VIN** (Very Important Note) These dialogue boxes do look similar so make sure you have the correct dialogue box in front of you. It should have **Save As** on the Title Bar.

Look **Save As**

When you have given the file a name and location click on save and from now on Word will save without all this rigmarole. Remember you have to tell it to save though!! The active document is shown on the Title Bar.

Once we have saved the file, when we click on the Save icon Word will save any further changes without prompting for names etc.
Exercise 4

Lets save our two open documents as *Letter to John* and *Memo to John*

Save them to your desktop as well

Sometimes you do not want to save with the same name. Maybe after 4 hours of typing you have written a letter to a family member. You could tell the same news to other people but they get offended with a photocopy or a Dear All letter. So you could save it with a different filename and enter the required details on that file. This can be tricky so keep alert. We could now have Letter2Phoebe 13Mar01 and Letter2Snow 13Mar01.

To reiterate and clarify

If we are working on a saved document and we press Save or (CTRL + S) Word will save the file with all the changes to date.

If we are working on a saved document and go to FILE and CLICK on **Save As** then Word will save the document with the new name you give it with all the changes since your last save

Exercise 5

Now we have another slacker in the organisation called (your choice) so we can send them a memo like John received. Make sure *Memo to John* is active and change the name and of the recipient and then create another file using **Save As** with the filename *Memo to (your choice)*

Close Word and have a breather.
Different views in Word

The screen shot below shows our programme and document windows maximised.

If you have not maximised the document window, your screen may look like this below with the filename in the document title bar.

It is up to you how you look at the screen - I am a big fan of using my entire screen so I maximise both windows by clicking.

Exercise 6

Open the document Saving Exercise 96

Save it as Saving Exercise 97

Change the text as shown here in italics

In March 1997 we will be holding our second National Conference. The event has been organised to help all parts of our organisation keep in touch with new company initiatives, and to provide input to these processes. This conference is for all employees and we will be inviting guest speakers from many facets of our business.

The conference will be held on the 12th, 13th and 14th of March, 1997 at the Sheraton Brisbane Hotel. On the final night of the conference a Gala Dinner will be held.

Save this document.

Check to see you have two documents with different information.

Save Saving Exercise 97 as Saving Exercise 98 and change the same details. Have you now 3 documents with the correct information? I'm sure you do.
Selecting

We have been typing and adjusting but if we want to complete some serious word processing we need to learn selection. No, not selecting land!

In order to change data we need to select what we want changed and then do the changes. It is a bit like throwing someone out of the pub – you grab them by the whatever and then change their location and/or shape.

Here are some selection techniques

Select text and graphics by using the mouse and other ways

<table>
<thead>
<tr>
<th>To select</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any amount of text</td>
<td>Click and Drag over the text</td>
</tr>
<tr>
<td>A word</td>
<td>Double-click the word</td>
</tr>
<tr>
<td>A graphic</td>
<td>Click the graphic</td>
</tr>
<tr>
<td>A line of text</td>
<td>Move the pointer to the left of the line until it changes to a right-pointing arrow, and then click.</td>
</tr>
<tr>
<td>Multiple lines of text</td>
<td>Move the pointer to the left of the lines until it changes to a right-pointing arrow, click and hold down the left mouse button and then drag up or down.</td>
</tr>
<tr>
<td>A sentence</td>
<td>Hold down &lt;CTRL&gt;, and then click anywhere in the sentence</td>
</tr>
<tr>
<td>A paragraph</td>
<td>Move the pointer to the left of the paragraph until it changes to a right-pointing arrow, and then double-click. Or triple-click anywhere in the paragraph. You can also hold down the shift key and use the arrow keys to select text.</td>
</tr>
<tr>
<td>Multiple paragraphs</td>
<td>Move the pointer to the left of the paragraphs until it changes to a right-pointing arrow, and then double-click and drag up or down.</td>
</tr>
<tr>
<td>A large block of text</td>
<td>Click at the start of the selection, scroll to the end of the selection, and then hold down &lt;Shift&gt; and click.</td>
</tr>
</tbody>
</table>
| An entire document      | 1. Move the pointer to the left of any document text until it changes to a right-pointing arrow, and then triple-click.  
                              2. Hold down <CTRL> and press the key A  
                              3. Go to the Edit menu and pick Select All |
Microsoft Word

Formatting

Now that we know how to select we can format.

A quick and very convenient way to change the formatting of our document is to use the buttons on the formatting toolbar.

The ones most commonly used are

The font is Baskerville and by clicking on the drop down arrow we can access more fonts.

The font size is 10 and by clicking on the drop down arrow we can change the font size.

Be aware that if you have a page of text in Baskerville size 14, it does not mean necessarily a page of text in another font of size 14 – eg

| How long or far does this go | Comic Sans Size 14 |
| How long or far does this go | Bernhard Modern Roman Size 14 |
| How long or far does this go | Times New Roman Size 14 |

To highlight text we can use the

- B stands for Bold
- I stands for Italics
- U stands for Underline

Exercise 7

Open the file Activity 2 and follow the instructions
Activity 2

Activity 2. "Formatting Italian Style"

5 Things you didn't know about Italy.

All gondolas in Venice must be painted black, unless they belong to a high official.
Leonardo De Vinci invented the scissors.
The most common name in Italy is Mario Rossi.
The mozzarella cheese originally used in Italy as a pizza topping, was made from the milk of the water buffalo (and still is today).
There is a city called Rome or Roma in every continent.

The sentence starting “Activity 2..” will be Arial 36, Bold and Underlined
The sentence starting “Five things..” will be Arial 20, Bold and italicised
The sentence starting “All gondolas..” will be Comic Sans 16
The sentence starting “Leonardo..” will be Comic Sans 14
The sentence starting “The most..” will be Times New Roman 12
The sentence starting “The mozzarella..” will be any font starting with H and 16
The sentence starting “There is ..” will be Wingdings 16
Alignment

Text can be aligned four ways

- **Left Aligned**
  Most of the time we use a left alignment just like this paragraph. It starts from the left margin and reaches towards the right margin and **Word** does that word-wrap thing and all the text is perfectly aligned on the left margin.

- **Right Aligned**
  Some times we use a right alignment just like this paragraph. It starts from the right margin and reaches towards the left margin and **Word** does that word-wrap thing and all the text is perfectly aligned on the right margin.

- **Centre Aligned**
  Some times we use a centre alignment just like this paragraph. It starts from the centre and reaches towards the left and right margin and **Word** does that word-wrap thing and all the text is perfectly aligned on the centre.

- **Justified**
  Sometimes we use a justified alignment just like this paragraph. It starts from the left margin and reaches towards the right margin and **Word** does that word-wrap thing and all the text is perfectly aligned on the left and right margins. **Word** only justifies a line that is close to being across the page. (see this line does not reach across).

**Exercise 8**

Open your file *Letter to John* and complete the following

- Right align your address
- Bold and up the font size of your *name*
- **Bold** my name
- Centre align the line starting “Re: …”
- Right align your closing salutation (all of it) and save and close this document
Cut, Copy Paste Spelling

Cut

When we cut text from a document it is removed from the document and placed on the clip board.

Select the text

From the Edit menu, click on Cut

or

Click once on the button on the toolbar

or

Using the key board, hold down the <CTRL> button and press the X key

or

Right click over the selection and pick Cut

Copy

When we copy text from a document, the original is left in the document and a copy is placed on the clip board.

Select the text

From the Edit menu, click on Copy

or

Click once on the button on the toolbar

or

Using the key board, hold down the <CTRL> button and press the C key

or

Right click over the selection and pick Copy
Paste

When we paste text from the clipboard, it is pasted where the insertion point is. The clipboard keeps a copy of the text in the clipboard so we can paste as many times as we like.

Select the insertion point

From the Edit menu, click on Paste

or

Click once on the button on the toolbar

or

Using the key board, hold down the <CTRL> button and press the V key

or

Right click over the selection and pick Paste

Spelling

From the Tools menu, click on Spelling

or

Click once on the button on the toolbar

or

Using the key board, press the F7 button

And now for something very familiar – an exercise

Exercise 9

Open the file Practice Cut Paste and Formatting

The sentence starting “End-User..” will be Bold and of a size to stretch across the page
All other text shall be Arial Size 12 with NO underlining and left aligned

Cut and paste all paragraphs so that the numbering is in order

Save and close that document
Word does not like my spelling of *blued* and so it has offered up some suggestions like bleed, bled, blood etc. If I had really wanted to use the word bluffed I would have to click on the word bluffed in the lower box and then click on Change.

If I click on the Change All button Word will change all further instances of *blued* to bluffed.

If I was happy with my spelling of *blued* I can tell Word to Ignore and if I had used *blued* further on in my document I can tell Word to Ignore All and Word would ignore further spellings of *blued*.

I can also tell Word to Add the word to the custom dictionary and then it would never ask me again if I wanted to spell *blued* another way.

Word does a good job but if a word is spelt correctly but it’s the wrong word, then Word will not pick it up. Be aware!!

What better way to remember this than to practice this

Open the document **Spell Check** and improve the spelling
More Formatting

A quick and very convenient way to change the formatting of our document is to use the buttons on the formatting toolbar.

The ones most commonly used are

The font is **Baskerville** and by clicking on the drop down arrow we can access more fonts

The font size is **10** and by clicking on the drop down arrow we can change the font size

To access more choices, select the text and from the **Format** menu, click on **Font**...
Can you list the shortcut keys to get here?

This dialogue box appears and look at the choices

Water is **H₂O** and **BATHURST** is capitalised and approximately **1000m²** is a ¼ of an **acre**

**Exercise 10**

Open the file “**All formatting**” and do what it says. Print it and compare with my answer
Microsoft Word

File Open and Save As

If we click on the Open icon, Word will open in a folder that has been preset, usually My Documents. (In my screen shot I have mine set to a different folder.)

We can ask to look in a different location by telling it to Look in:

- Click on the Drop Down Arrow to find more choices
- Here I have chosen the 3 1/2 Floppy (A:) - look it is shaded

Save As will open a similar dialogue box where we can change the folder that we will save the document to.

Exercise 11

Open the document Letter to John and save it to the floppy disc.
Open the document Memo to John and save it to the floppy disc. Insert the word MEMO at the top of the document and format the document appropriately. Save and close the document.
Microsoft Word
Page Setup

From the **File** menu, choose **Page Setup**…

If the text is “blued up”, you can type directly over the text. You can use the small arrows to change the margin as well. Use the Tab button on your keyboard to move to the next margin category. When the margins are set click on the next tab named **Paper Size**

Now check the other tabs named **Paper Source** and **Layout**

Rather then clicking on the tabs can you think of an **ALT**ernative method? ……